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  บทคัดย่อ


	 บทความนี้มีวัตถุประสงค์เพื่อแนะนำศักยภาพของโปรแกรม Mplus ในการวิเคราะห์ข้อมูลทางสถิติขั้นสูง

ในงานวิจัย เนื่องจากเป็นโปรแกรมที่มีศักยภาพสูงสุด  สามารถวิเคราะห์โมเดลสมการโครงสร้างพหุระดับ ซึ่งเป็นวิธี

วิทยาการวิจัยที่พัฒนาเพื่อการวิเคราะห์ข้อมูลให้สอดคล้องกับสภาพความสลับซับซ้อนตามความเป็นจริงของ

ธรรมชาติข้อมูลได้มากที่สุดในปัจจุบัน  และยังเป็นโปรแกรมที่มีศักยภาพในการวิเคราะห์ข้อมูลทางสถิติขั้นสูงในงาน

วิจัยครอบคลุมทั้งโมเดลเดี่ยวและโมเดลพหุระดับ  ในการจัดเตรียมข้อมูลผู้วิจัยต้องตระหนักถึงรายละเอียดตัวแปร  

ที่จะต้องนำไประบุในชุดคำสั่งสำหรับการระบุชื่อและชนิดตัวแปรที่ใช้ในการวิเคราะห์ โดยการจัดเตรียมข้อมูลนำเข้า

สามารถจัดเตรียมด้วยโปรแกรม SPSS เสร็จแล้วแปลงไฟล์ข้อมูลให้เป็นภาษา ASCII ก่อนการวิเคราะห์ข้อมูลด้วย

โปรแกรม Mplus  การวิเคราะห์ข้อมูลใช้หลักการเขียนคำสั่งเป็นภาษา Mplus  สามารถทำได้ 2 วิธีคือ  (1) เขียนคำ

สั่งโดยตรงลงในหน้าต่าง Syntax หรือ (2) สามารถใช้วิธีการกดปุ่มเมนูคำสั่งเบื้องต้นจากโปรแกรม โดยวิธีนี้เมื่อเสร็จ

แล้วโปรแกรมจะแสดงชุดคำสั่งเบื้องต้นให้ในหน้าต่าง  Syntax บางชุดคำสั่ง ซึ่งผู้วิจัยสามารถทำการระบุชุดคำสั่งใน

ส่วนที่โปรแกรมไม่ได้ระบุเพิ่มเติมได้  คำสั่งในโปรแกรม Mplus ประกอบด้วยชุดคำสั่งจำนวน 10 ชุด ดังนี้ (1) คำสั่ง

สำหรับระบุชื่อเรื่องในการวิเคราะห์ (TITLE) (2) คำสั่งสำหรับระบุแหล่งที่เก็บข้อมูล (DATA) (3) คำสั่งสำหรับการ

ระบุชื่อและชนิดตัวแปรที่ใช้ในการวิเคราะห์ (VARIABLE)  (4) คำสั่งสำหรับระบุเปลี่ยนรูปตัวแปรเพื่อสร้างเป็น

ตัวแปรใหม่ (DEFINE) (5) คำสั่งสำหรับระบุประเภทการวิเคราะห์และวิธีการประมาณค่า (ANALYSIS) (6) คำสั่ง

สำหรับบรรยายลักษณะในการระบุโมเดล (MODEL) (7) คำสั่งสำหรับระบุผลการวิเคราะห์ข้อมูลที่ต้องการ               

(OUTPUT) (8) คำสั่งสำหรับการระบุแหล่งบันทึกผลการวิเคราะห์ (SAVEDATA) (9) คำสั่งระบุสำหรับให้แสดงกราฟ      

(PLOT) (10) คำสั่งสำหรับระบุให้ใช้การสร้างสถานการณ์จำลอง (MONTECARLO)
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  Abstract


	 This article aims to introduce the potential of the Mplus program to analyze data using 

advanced statistical research that the program has reached its maximum capacity. This program 

can analyze the multilevel structural equation models which are developed to analyze data in 

accordance with the conditions of the naturally complex of the most current data. It also has 

potential applications in data analysis, advanced statistical research covering both single models 

and multilevel models. In preparing the data, the researcher must be aware of detailed variables 

that must be specified in the instructions for the name and type of used parameters in the 

analysis. By arranging input data can be provided by SPSS, after that converting data into language 

ASCII before data analysis by using Mplus. The principle of data analysis by using Mplus can be 

done to ways: (1) Write orders directly into the Syntax window, or (2) press the button menu 

commands from the basic program. When done this way, the program will display the basic set of 

instructions in the Syntax window, some instruction by the researcher can specify the order set in 

which the program does not specify further. The commands in the program Mplus includes 10  

sets of instructions (1) Identifying the analysis title command (TITLE) (2) Identifying source of data 

command (DATA) (3) Identifying name and type of variable command (VARIABLE) (4) Changing 

variable and defining new variable (DEFINE) (5) Identifying type of analysis and estimation method 

command (ANALYSIS) (6) Describing the characteristic of model command (MODEL) (7) Identifying 

required data analysis command (OUTPUT) (8) Saving data command (SAVEDATA) (9) Showing 

graphs command     (PLOT) (10) Making a simulation command (MONTECARLO).





Keywords: Multilevel Structural Equation Modeling, Multilevel Analysis using Mplus Program, Mplus Program.


 ความเป็นมาและความสำคัญของปัญหา


เนื่องจากโครงสร้างธรรมชาติของข้อมูลทาง

เศรษฐกิจและสังคม มักเกี่ยวข้องกับข้อมูลหลายระดับ 

และมีลักษณะเป็นโครงสร้าง การวิเคราะห์ข้อมูลตาม

ธรรมเนียมปฏิบัติที่ผ่านมา นิยมทำการวิเคราะห์ข้อมูล

แบบระดับเดียวมักละเลยต่อโครงสร้างของข้อมูล  และ

ละเลยต่อการศึกษาปฏิสัมพันธ์ระหว่างตัวแปรที่อยู่ต่าง

ระดับในลักษณะเชิงลดหลั่นกัน ส่งผลทำให้ผลการวิจัยที่

ผ่านมาทางสังคมศาสตร์และพฤติกรรมศาสตร์ไม่สามารถ

ให้ผลการสรุปที่ถูกต้อง  จึงได้เกิดวิธีวิทยาการวิจัยใหม่ๆ 

ขึ้นที่สามารถทำการวิเคราะห์ข้อมูลให้สอดคล้องกับ

สภาพธรรมชาติตามความเป็นจริงของข้อมูลได้มากที่สุด 

อันได้แก่ เทคนิคโมเดลสมการโครงสร้าง (Structural 

Equation Models) และเทคนิคการวิเคราะห์พหุระดับ 

(Multilevel Analysis) โดยเทคนิคโมเดลสมการ

โครงสร้าง (Structural Equation Models: SEM) เป็น

วิธีวิทยาการวิจัยที่สามารถทำการวิเคราะห์ข้อมูลที่มี

ลักษณะเป็นโครงสร้าง สามารถทำการวิเคราะห์ได้ด้วย

โปรแกรม LISREL, AMOS, EQS, PLS, CALIS, COSAN, 

LISCOMP หรือโปรแกรมอื่นๆ  แต่โปรแกรมเหล่านี้ยังมี

จุดด้อยที่ไม่สามารถทำการวิเคราะห์ข้อมูลที่อยู่ต่างระดับ

ในลักษณะเชิงลดหลั่น (hierarchical) หรือข้อมูลที่อยู่ใน

ลักษณะพหุระดับได้ (multilevel Data) ส่วนเทคนิค

การวิเคราะห์พหุระดับ (multilevel Analysis) เป็นวิธี

วิทยาการวิจัยที่สามารถทำการวิเคราะห์ข้อมูลต่างระดับ

ในลักษณะเชิงลดหลั่นได้ โดยใช้โปรแกรม HLM หรือ
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เทคนิค Hierarchical Linear Modeling หรือเทคนิค

อื่นๆ เช่น Cross-level Operator Analysis (CLOP), 

Within and Between Analysis (WABA) เป็นต้น แต่

สถิติหรือโปรแกรมเหล่านี้ก็ยังมีจุดด้อยที่ไม่สามารถ

ทำการวิเคราะห์ข้อมูลที่มีลักษณะเป็นโครงสร้างได้เช่น

เดียวกัน  


จุดด้อยที่สำคัญของวิธีวิทยาการวิจัยที่ผ่านมา  

คือสถิติหรือโปรแกรมที่ใช้ในการวิเคราะห์ข้อมูลที่มีอยู่

เดิมมีข้อจำกัดไม่สามารถให้ผลการวิเคราะห์ที่ตอบ

คำถามวิจัยที่สลับซับซ้อนได ้ทำให้วิธีวิทยาการวิจัยได้

พัฒนาถึงจุดเปลี่ยนสำคัญ เกิดเทคนิคโมเดลสมการ

โครงสร้างพหุระดับ (Multilevel Structural Equation 

Models) หรือเป็นที่รู้จักเรียกกันในชื่อสั้นๆ ว่า 

Multilevel SEM ซึ่งเป็นวิธีวิทยาการวิจัยที่พัฒนาได้

สอดคล้องกับสภาพที่เป็นข้อเท็จจริงของข้อมูลได้มาก

ที่สุดในสภาพแนวโน้มปัจจุบัน เพราะเป็นเทคนิคที่

สามารถวิเคราะห์ข้อมูลที่มีลักษณะเป็นโครงสร้างและอยู่

ต่างระดับในลักษณะที่ลดหลั่นไปพร้อมๆ กันได้ โดย

โปรแกรมที่สามารถทำการวิเคราะห์เทคนิคโมเดลสมการ

โครงสร้างพหุระดับได้คือโปรแกรม Mplus ซึ่งเป็น

โปรแกรมที่ดีที่สุดโปรแกรมหนึ่งในปัจจุบันที่มีศักยภาพ

สูงสุด สามารถทำการวิเคราะห์ข้อมูลได้สอดคล้องกับ

สภาพธรรมชาติตามความเป็นจริงของข้อมูลได้ดีที่สุด ซึ่ง

โปรแกรม Mplus นอกจากจะสามารถวิเคราะห์โมเดล

สมการโครงสร้างพหุระดับดังกล่าวได้แล้ว  ยังมีความ

โดดเด่นในเรื่องการออกแบบเพื่อให้มีศักยภาพในการ

วิเคราะห์ข้อมูลทางสถิติขั้นสูงในงานวิจัยได้ครอบคลุมทั้ง

โมเดลเดี่ยว (Single Model) และโมเดลพหุระดับ         

(Multilevel Model) อีกด้วย


โปรแกรม Mplus พัฒนาโดย L. K. Muthen,   

and B. O. Muthen, (2008). สองสามีภรรยาตั้งแต่ปี 

1998 จนกระทั่งปัจจุบัน  นับเป็นโปรแกรมที่มีแนวโน้ม

สำคัญ ในการวิเคราะห์ข้อมูลทางสถิติขั้นสูงในงานวิจัย  

เพราะมีการพัฒนาอย่างต่อเนื่อง โปรแกรม Mplus 

สามารถออกแบบวิธีการวิเคราะห์ข้อมูลเป็นรูปแบบ

เดียวกันเกือบทุกโมเดล เพื่อลดความยุ่งยากในขั้นตอน

ของการวิเคราะห์สถิติขั้นสูงของโปรแกรมดั้งเดิมที่ใช้

วิเคราะห์กันอยู่โดยทั่วไป โดยสามารถ Click คำสั่งจาก

เมนูเพื่อให้โปรแกรมเขียนชุดคำสั่งใน Syntax เบื้องต้น

ได้โดยไม่ต้องเขียนชุดคำสั่งใน Syntax เองทั้งหมด  และ

ผู้วิจัยเพียงพิมพ์ชุดคำสั่งเพิ่มเติมในส่วนของ MODEL ก็

สามารถวิเคราะห์ข้อมูลได้แล้ว  


นอกจากนี้ศักยภาพของ Multilevel SEM 

เป็นสถิติวิเคราะห์ที่เหมาะสมมากที่สุดกับงานวิจัยทุก

สาขาวิชาในปัจจุบัน โดยข้อดีของโปรแกรม Mplus  ใน

การเขียนคำสั่งไม่ต้องเสียเวลาจำเมทริกซ์พารามิเตอร์

เหมือนกับในโปรแกรม LISREL และในกรณีที่ต้องการ

วิเคราะห์ข้อมูลพหุระดับก็สามารถเตรียมไฟล์ข้อมูลให้

เสร็จสิ้นได้เพียงไฟล์เดียว โดยไม่ต้องแยกไฟล์ข้อมูลให้

ยุ่งยากเหมือนกับโปรแกรม HLM ทำให้นักวิจัยสามารถ

เตรียมและเก็บไฟล์ข้อมูลได้อย่างสะดวกมากขึ้น ซึ่งผู้ที่มี

ความรู้พื้นฐานในเรื่องการวิ เคราะห์โมเดลสมการ

โครงสร้าง (Structural Equation Models) ด้วย

โปรแกรม LISREL และการวิเคราะห์พหุระดับ             

(Multi-level Analysis) ด้วยโปรแกรม HLM  หากเมื่อ

ได้ศึกษาตัวอย่างคำสั่งในโปรแกรม  Mplus  แล้วจะ

สามารถเข้าใจการเขียนคำสั่งในโปรแกรม Mplus ได้โดย

ง่าย ซึ่งบทความนี้เรียบเรียงขึ้นสำหรับผู้อ่านที่มีพื้นฐาน

ความรู้ในเรื่องโมเดลสมการโครงสร้างและการวิเคราะห์

ข้อมูลพหุระดับ โดยโปรแกรม Mplus ออกแบบให้

สามารถวิเคราะห์ตัวแปรจัดประเภท (categorical) ได้

สะดวก ซึ่งแตกต่างจากโปรแกรมโดยทั่วไปที่นิยม

ออกแบบการวิเคราะห์ด้วยตัวแปรประเภทต่อเนื่อง          

(continuous) เป็นหลัก นอกจากนี้โปรแกรม Mplus    

ยังเป็นโปรแกรมที่สามารถคลายข้อตกลงเบื้องต้นได้สูง 

สามารถเลือกวิธีการประมาณค่าได้หลายแบบเพื่อให้

เหมาะสมกับข้อมูลที่ใช้ในการวิเคราะห์  เหมาะสำหรับ

การวิเคราะห์ข้อมูลพหุระดับที่มีขนาดข้อมูลในแต่ละ

กลุ่มไม่เท่ากัน และการแจกแจงของข้อมูลไม่เป็นโค้งปกติ 

สามารถคำนวณค่าไค-สแควร์ (χ2) และค่าความคลาด

เคลื่อนมาตรฐานที่ถูกต้องสำหรับกรณีข้อมูลที่มีขนาดไม่

เท่ากัน โปรแกรมสามารถคำนวณค่าองค์ประกอบความ
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แปรปรวนและค่าสหสัมพันธ์ภายในระดับชั้นให้โดย

อัตโนมัติ  และให้ผลที่ใกล้เคียงกับการคำนวณด้วย

โปรแกรม HLM  สามารถนำทั้งค่า Intercept และ 

Slope มาวิเคราะห์เป็นตัวแปรตามในระดับมหภาคได้     

(Macro) สามารถคำนวณขนาดอิทธิพลทางตรงและ

อิทธิพลทางอ้อมได้สะดวก  และสามารถวิเคราะห์โมเดล

ทุกประเภทในกรณีที่มีข้อมูลขาดหาย (missing data)

โดยการประมาณค่าทดแทน (imputation) เป็นต้น และ

ยังสามารถวิเคราะห์ข้อมูลที่ได้จากการสร้างสถานการณ์

จำลองแบบ monte carlo (monte carlo simulation) 

ได้ด้วย  นอกจากนี้โปรแกรม Mplus ยังมีจุดเด่นในเรื่อง

การวเิคราะหอ์งคป์ระกอบ (Factor Analysis) เปน็อยา่งมาก 

เพราะเป็นโปรแกรมที่สามารถวิเคราะห์องค์ประกอบได้

ทั้งการวิเคราะห์องค์ประกอบเชิงสำรวจ (Exploratory 

Factor Analysis: EFA) และการวิเคราะห์องค์ประกอบ

เชิงยืนยัน (Confirmatory Factor Analysis: CFA) ได้

ในโปรแกรมเดียวกัน ซึ่งเดิมการวิเคราะห์องค์ประกอบ

เชิงสำรวจ (EFA) สามารถวิเคราะห์ได้ด้วยโปรแกรม 

SPSS ส่วนการวิเคราะห์องค์ประกอบเชิงยืนยัน (CFA) 

สามารถทำการวิเคราะห์ได้ด้วยโปรแกรม LISREL, 

AMOS, PLS หรือโปรแกรมอื่นๆ   


โปรแกรม  Mplus นับได้ว่าเป็นสินค้าทดแทน

ของโปรแกรมการวิเคราะห์ทางสถิติขั้นสูงในงานวิจัย

เกี่ยวกับการวิเคราะห์โมเดลสมการโครงสร้างและการ

วิเคราะห์พหุระดับ เพราะเนื่องจากศักยภาพของ

โปรแกรม Mplus สามารถนำมาวิเคราะห์สถิติขั้นสูงใน

งานวิจัยที่มีอยู่เดิม โดยทั่วไปที่สามารถนำมาวิเคราะห์ได้

ด้วยโปรแกรม LISREL, AMOS, EQS, PLS, HLM และ

โปรแกรมอื่นๆ อีกจำนวนมาก สามารถนำมาวิเคราะห์ได้

ด้วยโปรแกรม Mplus ได้เกือบทั้งหมด อีกทั้งยังเป็น

โปรแกรมที่มีศักยภาพสูงสุดสามารถนำมาวิเคราะห์ 

Multilevel SEM ได้ด้วย นับได้ว่าเป็นศักยภาพของวิธี

วิทยาการวิจัยที่สามารถพัฒนาได้สอดคล้องกับสภาพ

แวดล้อมแห่งการเปลี่ยนแปลงในยุคโลกาภิวัตน์ได้อย่าง

แท้จริง ซึ่งผู้ที่สนใจสามารถดาวน์โหลด (download) 

โปรแกรม Mplus Version Demo และคู่มือการใช้

โปรแกรม Mplus User’s Guide ได้ที่เว็บไซต์  www.

StatModel.com หรือสามารถโต้ตอบกับผู้พัฒนา

โปรแกรมได้โดยตรงที่  Support@StatModel.com





  การจัดเตรียมข้อมูลนำเข้า


การจัดเตรียมข้อมูลนำเข้าสำหรับการวิเคราะห์

ด้วยโปรกรม Mplus สามารถจัดเตรียมข้อมูลนำเข้าด้วย

โปรแกรม SPSS โดยสามารถจัดเตรียมข้อมูลทั้งหมดให้

อยู่ในไฟล์เดียวกัน แต่ต้องไม่เกินจำนวน 80 คอลัมภ์  

เสร็จแล้วแปลงไฟล์ข้อมูลให้เป็นภาษา ASCII โดยการ

บันทึก Save as type: Fixed ASCII(*.dat) หรือ Save 

as type: Tab-delimited(*.dat)  เมื่อบันทึกเสร็จแล้ว  

ข้อมูลจะอยู่ในไฟล์นามสกุล .dat  ซึ่งสามารถเปิดดูได้

ด้วยโปรแกรม Notepad 


ในการจัดเตรียมข้อมูล  ผู้วิจัยต้องตระหนักถึง

การจัดเตรียมตัวแปรทั้งหมดที่มีในไฟล์ข้อมูล  ซึ่งจะต้อง

นำไปกำหนดเป็นรายละเอียดในชุดคำสั่งสำหรับระบุชื่อ

และชนิดตัวแปรที่ใช้ในการวิเคราะห์ (VARIABLE) ซึ่งมี

รายละเอียดเบื้องต้นที่สำคัญดังนี้


NAMES ARE คือชื่อตัวแปรทั้งหมดที่มีในไฟล์ 

.dat (ต้องมี)


USEVARIABLES ARE คือชื่อตัวแปรที่จะใช้

วิเคราะห์ทั้งหมด (ต้องมี)


GROUPING  คือตัวแปรที่ใช้แบ่งกลุ่มในการ

วิเคราะห์ Multiple group 


CLUSTER คือตัวแปรที่ใช้แบ่งระดับในการ

วิเคราะห์ Multilevel 


WITHIN คือตัวแปรสังเกตได้ระดับบุคคลที่นำ

มาวเิคราะห ์Multilevel (การวเิคราะห ์Multilevel ตอ้งม)ี


BETWEEN คือตัวแปรสังเกตได้ระดับกลุ่มที่นำ

มาวเิคราะห ์Multilevel (การวเิคราะห ์Multilevel ตอ้งม)ี


CATEGORICAL คือชื่อตัวแปรจัดประเภทหรือ

ตัวแปร Dummy Variable (ถ้ามี)


CENTERING คอืชือ่ตวัแปรทีเ่ปน็  GRANDMEAN  

(xm); (ถ้ามี)
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  ภาษา Mplus


เนื่องจากโปรแกรม Mplus ใช้วิธีการวิเคราะห์

ข้อมูลโดยการเขียนคำสั่งเป็นภาษา Mplus ลงใน

หน้าต่าง Syntax ดังนั้นภาษา  Mplus  จึงหมายถึงชุด

คำสั่ง (command) ที่ผู้วิจัยจะต้องระบุลงในหน้าต่าง 

Syntax ซึ่งสามารถทำได้โดย (1) การเขียนชุดคำสั่งลงใน

หน้าต่าง Syntax โดยตรงหรือ (2) สามารถใช้วิธีการ 

Click เมนูคำสั่งเบื้องต้นจากโปรแกรม โดยวิธีนี้เมื่อเสร็จ

แล้วโปรแกรมสามารถแสดงชุดคำสั่งเบื้องต้นให้ใน

หน้าต่าง  Syntax เพียงจำนวน 6 ชุดคำสั่งเท่านั้นคือ 

TITLE, DATA, VARIABLE, ANALYSIS, OUTPUT, 

SAVEDATA  ส่วนอีก 4  ชุดคำสั่งที่เหลือคือ DEFINE, 

MODEL, PLOT, MONTECARLO ผู้วิจัยสามารถทำการ

ระบุเพิ่มเติมได้โดยตรงในหน้าต่าง  Syntax  ซึ่งภาษา 

Mplus ประกอบด้วยชุดคำสั่งจำนวน 10 ชุดคำสั่ง  ซึ่ง

แสดงรายละเอียดดังตาราง 1


ชุดคำสั่ง รายละเอียดชุดคำสั่ง 
TITLE เป็นคำสั่งสำหรับระบุชื่อเรื่องในการวิเคราะห์
DATA เป็นคำสั่งสำหรับระบุแหล่งที่เก็บข้อมูล (Directory) 

VARIABLE คำสั่งระบุชื่อและชนิดตัวแปรที่ใช้ในการวิเคราะห์
DEFINE คำสั่งระบุเปลี่ยนรูปตัวแปรที่มีอยู่เพื่อสร้างเป็นตัวแปรใหม่

ANALYSIS คำสั่งระบุประเภทการวิเคราะห์และวิธีการประมาณค่า
MODEL คำสั่งบรรยายลักษณะในการระบุโมเดล
OUTPUT คำสั่งระบุผลการวิเคราะห์ข้อมูลที่ต้องการ
SAVEDATA คำสั่งสำหรับการระบุแหล่งบันทึกผลการวิเคราะห์

PLOT คำสั่งระบุให้แสดงกราฟ
MONTECARLO คำสั่งระบุให้ใช้การสร้างสถานการณ์จำลอง

ตาราง 1


ชุดคำสั่งภาษา Mplus


อนึ่งในการวิเคราะห์ข้อมูลแต่ละครั้งไม่จำเป็น

ต้องมีชุดคำสั่งครบทั้ง 10  ชุดคำสั่ง โปรแกรมก็สามารถ

แสดงผลการวิเคราะห์ได้  โดยหลักการเขียนคำสั่งใน

โปรแกรม  Mplus  มีหลักการดังนี้


(1) การพิมพ์ชื่อชุดคำสั่งต้องขึ้นบรรทัดใหม่

พิมพ์ด้วยอักษรตัวพิมพ์ใหญ่ชิดซ้าย  ปิดด้วยเครื่องหมาย 

Colon (:) ชื่อชุดคำสั่งเมื่อพิมพ์เสร็จแล้วโปรแกรมจะ

แสดงให้เห็นเป็นอักษรสีน้ำเงิน 


(2) รายละเอียดในแต่ละชุดคำสั่ง  สามารถ

พิมพ์ได้ด้วยอักษรตัวพิมพ์เล็กหรือพิมพ์ใหญ่ ปิดด้วย

เครื่องหมาย Semicolon (;) 


(3) ในการเขียนคำสั่ง  IS หรือ ARE  สามารถ

เขียนแทนได้ด้วยเครื่องหมาย = ยกเว้นชุดคำสั่ง DEFINE 

และ MODEL 


(4) สามารถใช้เครื่องหมาย Hyphen (-) คั่น

กลางชื่อตัวแปรที่เหมือนกันได้ เช่น x1-x6





  ขั้นตอนการวิเคราะห์ข้อมูลด้วยโปรแกรม    
 

   Mplus


เปิดโปรแกรม  Mplus โปรแกรมจะแสดง

หน้าต่าง Syntax ว่าง  ซึ่งเป็นหน้าต่างที่ยังไม่มีราย

ละเอียดให้อัตโนมัติ ชื่อไฟล์ Mptext1 ถ้าโปรแกรมไม่

แสดงหน้าต่าง Syntax ให้ Click ที่เมนู File>New แล้ว

โปรแกรมจะแสดงหน้าต่าง Syntax นี้ให้ ซึ่งหน้าต่างนี้

สามารถใช้วิธีเขียนคำสั่งโดยตรงด้วยภาษา Mplus แต่

สำหรับบทความวิชาการนี้  จะใช้วิธีการ Click เมนูคำสั่ง

เบื้องต้น เพื่อให้โปรแกรมเขียนคำสั่งลงในหน้าต่าง 

Syntax ให้เบื้องต้น โดยไม่ต้องเขียนคำสั่งเองโดยตรง
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ทั้งหมด หลังจากนั้นทำการเขียนคำสั่งในส่วนของ 

MODEL เพิ่มเติมก่อนการสั่งวิเคราะห์ข้อมูล (Run)


โดยขั้ นตอนในการวิ เคราะห์ ข้ อมู ลด้ วย

โปรแกรม Mplus เริ่มต้นที่ เมนู File>Mplus>

Language Generator> เลือกโมเดลซึ่งมีให้เลือก 4  

ชนิด คือ (1) SEM (มี 3 แบบคือ SEM, SEM with 

Missing data, SEM with Clustered data) (2) 

Mixture (3) EFA (มี 2 แบบคือ EFA และ EFA with 

Missing data) และ (4) Logistic>โปรแกรมจะแสดง

หน้าต่าง Structural Equation  Modeling  ให้กำหนด

เลือกหรือระบุคำสั่งจากหน้าต่าง Structural Equation  

Modeling  และ Next> ตามลำดับต่อเนื่องกันไปเรื่อยๆ 

จนกระทั่งเสร็จสิ้น  ตามลำดับ





























ภาพ 1  หน้าต่าง Structural Equation  Modeling  





เมนูสำหรับการระบุชุดคำสั่ง TITLE และ 

DATA


1 Title ให้พิมพ์ตั้งชื่อ  Data type             

Individual Summary  Data file ให้ Click 

Browse>Next


2 Data format ให้เลือก Free  Fixed   

Fixed format ฟร ี Missing data ใหเ้ลอืก Yes No  

Type of missing value flag โปรแกรมบังคับเลือก 
 

 Numeric>Next


เมนูสำหรับการระบุชุดคำสั่ง VARIABLE 

และ ANALYSIS


3 Variable names ให้พิมพ์ชื่อตัวแปรจัด
เรียงตามลำดับในไฟล์ข้อมูล โดยเว้นระยะห่างหนึ่งเคาะ
> Add เพื่อให้ตัวแปรไปอยู่ในช่อง Variable list>Next


4 Variable list เลอืกตวัแปรทีใ่ชว้เิคราะห>์Add  
เพือ่ใหต้วัแปรทีเ่ลอืกมาอยูใ่นชอ่ง Usevariable list>Next


5 ระบุประเภทตัวแปร ว่าตัวแปรใดเป็น 
Grouping Variable, Cluster Variable, Between 
Variable, Categorical Variable, Weight Variable,  
ตัวแปรในระดับที่ 2 หรือตัวแปรในระดับกลุ่มระบุเป็น
ประเภทตัวแปรเป็น Between Variable และตัวแปร 
Cluster ระบุประเภทตัวแปรเป็น Cluster Variable 
ส่วนตัวแปรต่อเนื่องถือเป็นตัวแปรเมตริก (Metric 
Variable)ไม่ต้องระบุประเภทตัวแปร  ทำการระบุ
ตัวแปรได้โดยการใช้ Mouse วางที่ตัวแปร แล้ว Click 
เลือกประเภทตัวแปรจาก Select/Remove  ฝั่งขวามือ
ของหน้าต่าง  แล้วโปรแกรมจะแสดงประเภทตัวแปรใน
ช่อง Function ตรงกับตัวแปรที่เลือกไว้>Next


6 ถ้าวิเคราะห์โมเดลเดี่ยวไม่ต้องระบุเลือก
ประเภทการวิเคราะห์ในหน้านี้เพราะโปรแกรมกำหนด
ให้ประมาณค่าด้วยวิธี ML แล้ว ถ้าวิเคราะห์ข้อมูลสอง
ระดับให้เลือก Analysis Type เป็น Twolevel 
โปรแกรมกำหนดประมาณค่าด้วยวิธี MLM>Next


เมนูสำหรับการระบุชุดคำสั่ง OUTPUT

7 กำหนดเลือก  Output Options  ตาม

ต้องการ>Next

เมนูสำหรับการระบุชุดคำสั่ง SAVEDATA

8 Savedata options ให้ระบุเลือก   
 

 Results และในช่อง File: ให้พิมพ์ \Mptext1>
Finish


9 โปรแกรมจะแสดงหน้าต่าง Syntax ที่ยังไม่

สมบูรณ์ชื่อ Mptext1 ซึ่งแสดงรายละเอียดที่ได้กำหนด

ด้วยเมนูคำสั่งเบื้องต้นไว้แล้ว> พร้อมแสดงหน้าต่าง 

Language Generator เตือนให้ทราบว่าโปรแกรมไม่ได้

เตรียมคำสั่ง MODEL และ DEFINE ไว้ให้> Click OK>

แล้วระบุคำสั่งโมเดลในส่วนของ MODEL ในหน้าต่าง 

Mptext1 เพิ่มเติม โดยพิมพ์ให้อยู่ระหว่างชุดคำสั่ง 

ANALYSIS และ OUTPUT
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การระบุรายละเอียดในส่วนของชุดคำสั่ ง  

MODEL เป็นการระบุสัญลักษณ์ของภาพโมเดลที่จะ

ทำการวิเคราะห์  ฉะนั้นจึงเป็นสิ่งจำเป็นที่ผู้วิจัยต้อง

ทำความเข้าใจภาพโมเดลของตนเองก่อนที่จะทำการ

วิเคราะห์ข้อมูล  และยังต้องทำความเข้าใจหลักการระบุ

โมเดลแต่ละโมเดลให้เข้าใจก่อนว่าโมเดลที่กำลังสนใจ

วิเคราะห์สามารถระบุสัญลักษณ์โมเดลอย่างไร  หลังจาก

นั้นนำรายละเอียดมาระบุในส่วนของ  MODEL โดย

ทำการพิมพ์รายละเอียดแทรกลงในหน้าต่าง Syntax 

ระหว่างชุดคำสั่ง ANALYSIS  กับ  OUTPUT โดย

สามารถทำความเข้าใจหลักการเบื้องต้นในการระบุ
 

โมเดลได้จากตาราง 3  ซึ่งตัวอย่างชุดคำสั่งในหน้าต่าง  

Syntax  ก่อนและหลังการระบุโมเดลมีลักษณะดัง
 

ตาราง 2 ดังนี้


ตัวอย่างชุดคำสั่งเบื้องต้น
 ตัวอย่างชุดคำสั่งหลังการระบุโมเดล


TITLE:  MplusMultilevel

DATA:
  FILE IS “D:\MplusMultilevel.dat”;

VARIABLE:
  NAMES ARE cluster x1 x2 x3 y w1 w2;
  USEVARIABLES ARE cluster x1 x2 x3 y w1 w2;
  CLUSTER IS cluster;
  BETWEEN ARE w1-w2;
  WITHIN ARE x1-x3;

ANALYSIS:
  TYPE IS TWOLEVEL RANDOM;
  ESTIMATOR IS MLR;
  ITERATIONS = 1000;
  CONVERGENCE = 0.000001;

OUTPUT:  
  SAMPSTAT RESIDUAL STANDARDIZED;

SAVEDATA:
  RESULTS IS D:\MplusMultilevel.Mptext1;

TITLE:  MplusMultilevel

DATA:
  FILE IS “D:\MplusMultilevel.dat”;

VARIABLE:
  NAMES ARE cluster x1 x2 x3 y w1 w2;
  USEVARIABLES ARE cluster x1 x2 x3 y w1 w2;
  CLUSTER IS cluster;
  BETWEEN ARE w1-w2;
  WITHIN ARE x1-x3;

ANALYSIS:
  TYPE IS TWOLEVEL RANDOM;
  ESTIMATOR IS MLR;
  ITERATIONS = 1000;
  CONVERGENCE = 0.000001;

MODEL:
  %WITHIN%
  s1 | y ON x1;
  s2 | y ON x2;
  s3 | y ON x3;
  %BETWEEN%
  y s1 s2 s3 ON w1;
  y s1 s2 s3 ON w2;

OUTPUT:  
  SAMPSTAT RESIDUAL STANDARDIZED;

SAVEDATA:
  RESULTS IS D:\MplusMultilevel.Mptext1;

ภาพ 2  ตัวอย่างหน้าต่าง Syntax ชื่อไฟล์ Mptext1 และหน้าต่าง Language Generator


ตาราง 2 


ตัวอย่างชุดคำสั่งก่อนและหลังการระบุโมเดลในหน้าต่าง Syntax 
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ข้อสังเกต  ในหน้าต่าง Syntax เมื่อเขียนชุดคำ

สั่งเสร็จเรียบร้อยแล้ว โปรแกรมจะแสดงชื่อชุดคำสั่งเป็น

ตัวอักษรสีน้ำเงิน  ส่วนรายละเอียดในชุดคำสั่งเป็นตัว

อักษรสีดำปกติ


10 เมื่อพิมพ์รายละเอียดแทรกในหน้าต่าง 

Syntax เสร็จแล้ว ก่อนการวิเคราะห์ผลให้บันทึก

หน้าต่าง  Syntax ที่เมนู File> Save as โปรแกรมจะ

แสดงชื่อไฟล์ Mptext1 นามสกุล Mplus input 

documents (*.inp) ให้ Click> save ไฟล์ใน drive ที่

ต้องการ


11 วิเคราะห์ผลโดยการ Click ที่ เมนู

สัญลักษณ์  >Save Changes to Mptext1? 

Click Yes โปรแกรมจะแสดงผลการวิเคราะห์ให้ใน

หน้าต่าง Mptext1.out> บันทึกหน้าต่างผลการ

วิเคราะห์ เมนู File> save as ไฟล์ใน drive ที่ต้องการ





  การระบุโมเดล (Model)


ชุดคำสั่งสำหรับการระบุโมเดล  ใช้หลักการ

แปลงภาษา Mplus ให้เป็นภาพโมเดล  หรือการแปลง

ภาพโมเดลให้เป็นภาษา Mplus นั่นเอง  เนื่องจาก

โปรแกรม Mplus ไม่สามารถวาดภาพโมเดลได้โดยตรง

เหมอืนกบัโปรแกรม LISREL, AMOS  หรอืโปรแกรมอืน่ๆ  

ดังนั้นผู้วิจัยต้องทำการแปลงภาพโมเดลให้เป็นสัญลักษณ์

ด้วยภาษา  Mplus  ซึ่งหลักการแปลงภาพโมเดลให้เป็น

สัญลักษณ์ด้วยภาษา Mplus สามารถใช้คำสั่งหลักได้

ดังนี้ (1) Factor ใช้คำสั่ง BY (Measure by) ในการระบุ

โมเดล โดยชื่อตัวแปรที่อยู่ข้างหน้าคำสั่ง BY  เป็น 

Factor ส่วนตัวแปรที่อยู่ข้างหลัง BY คือตัวแปรที่เป็น

องค์ประกอบของ Factor เขียนเชื่อมด้วยเส้นที่มีหัวลูก

ศรเหมือนกับ Factor Analysis (2) Regression ใช้คำ

สั่ง ON ระบุโมเดล โดยตัวแปรที่อยู่ข้างหน้าคำสั่ง ON 

คือตัวแปรตาม ซึ่งจะอยู่ในตำแหน่งหัวลูกศร ส่วนตัวแปร

อิสระจะอยู่หลังคำสั่ง ON จะอยู่ในตำแหน่งท้ายลูกศร 
 

(3) Correlation ใช้คำสั่ง WITH ระบุโมเดล โดยระบุ

ตัวแปรข้างหน้าและหลังคำสั่ง WITH ซึ่งมีลักษณะเป็น

เส้นโค้งที่มีหัวลูกศรเชื่อมระหว่างตัวแปร ซึ่งแสดงราย

ละเอียดดังตาราง  3 

ตาราง  3  


สัญลักษณ์และการระบุโมเดล


• Factor ใช้คำสั่ง BY (Measure by)












 

• Factor ใช้คำสั่ง BY








• Regression ใช้คำสั่ง ON














• Regression ใช้คำสั่ง ON











• Correlation ใช้คำสั่ง WITH














• Correlation ใช้คำสั่ง WITH





นอกจากนี้ยังมีสัญลักษ์อื่นๆ  

ในการระบุโมเดลเพิ่มเติม  เช่น  สัญลักษณ์  
|  ใช้ระบุความชันในสมการถดถอยแต่ละ
กลุ่มในระดับที่ 1 (จุดสีดำกลางลูกศร) โดย
การเขียนตัวอักษร  s ไว้ข้างหน้าสัญลักษณ์ |  

และตามด้วยการระบุโมเดลปกติ  

















MODEL:
F1 BY U1 U2 U3;

MODEL:
F1 BY X1 X2 X3;

MODEL:
F1 BY X1 X2 X3;
X1 WITH X2;

MODEL:
s1 | y ON x1;
s2 | y ON x2;

MODEL:
Y1 ON X1 X2 X3;

MODEL:
Y1 ON X1 X3;
Y2 ON Y1 X2 X3;

MODEL:
Y1 ON X1 X2 X3;
X1 WITH X2;

MODEL:

s | y ON x;
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ศักยภาพของโปรแกรม Mplus  กับการ

วิเคราะห์สถิติขั้นสูงในงานวิจัย


เนื่องจากข้อจำกัดและช่องว่างของโปรแกรมใน

การวิเคราะห์สถิติขั้นสูงที่มีอยู่เดิมไม่สามารถวิเคราะห์โม

เดลสมการโครงสร้างพหุระดับ (Multilevel Structural 

Equation Models) โปรแกรม Mplus มีศักยภาพสูงสุด

สามารถวิเคราะห์โมเดลดังกล่าวได้  นอกจากนั้นยัง

สามารถวิเคราะห์สถิติขั้นสูงในงานวิจัยได้ครอบคลุมโม

เดลในส่วนของโมเดลสมการโครงสร้าง (Structural 

Equation Models) และโมเดลเชิงลดหลั่น 
 

(Hierarchical Linear Modeling) ศักยภาพของ

โปรแกรม Mplus มีลักษณะที่โดดเด่นสามารถวิเคราะห์

ข้อมูลทางสถิติขั้นสูงได้เกือบทุกโมเดล  ครอบคลุมทั้งใน

ประเภทโมเดลเดี่ยว (Single Model) และโมเดลที่เป็น

พหุระดับ (Multilevel Model) ซึ่งแสดงตัวอย่างการ

วิเคราะห์บางโมเดลดังตาราง  4 และตาราง 5


โมเดลเดี่ยว (Single Model) โปรแกรม  

Mplus มีศักยภาพสามารถวิเคราะห์โมเดลเดี่ยวหรือโม

เดลทั่วไปทางสถิติขั้นสูงในงานวิจัยได้ตั้งแต่ Regression 

Analysis, Path Analysis, Exploratory Factor 

Analysis (EFA), Confirmatory Factor Analysis        

(CFA), Structural Equation Modeling (SEM), 

Latent Growth Model, Survival Analysis  เป็นต้น 

ซึ่งแสดงตัวอย่างการวิเคราะห์บางโมเดลดังตาราง  4


ตาราง 4  


ตัวอย่างการวิเคราะห์โมเดลเดี่ยว (Single Model) 


การวิเคราะห์ (Analysis) ภาพโมเดล การระบุโมเดล (Model)
Linear Regression Analysis MODEL:

y1 ON x1 x2 x3;

Path Analysis with Continuous Depen-
dent Variables

MODEL:
y1 y2 ON x1 x2 x3;
y3 ON y1 y2 x2;

CFA with Continuous Factor Indicators MODEL:
f1 BY y1-y3;
f2 BY y4-y6;

Second-Order Factor Analysis MODEL:
f1 BY y1-y3;
f2 BY y4-y6;
f3 BY y7-y9;
f4 BY f1-f3;

SEM with Continuous Factor Indicators MODEL:
f1 BY y1-y3;
f2 BY y4-y6;
f3 BY y7-y9;
f4 BY y10-y12;
f4 ON f3;
f3 ON f1 f2;
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โมเดลพหุระดับ (Multilevel Model) 

โปรแกรม Mplus มีศักยภาพสามารถวิเคราะห์โมเดล

สมการโครงสร้างพหุระดับ (Multilevel Structural 

Equation Models) อันประกอบด้วยสถิติต่อไปนี้คือ 

Multilevel Regression Analysis, Multilevel Path 

Analysis, Multilevel Factor Analysis, Multilevel 

SEM Full Model, Multilevel Growth Modeling, 

Multilevel Latent Class Analysis, Multilevel 

Latent Transition Analysis และ Multilevel 

Growth Mixture Modeling โมเดลพหุระดับ

ประกอบด้วยโมเดลการวิเคราะห์ในระดับที่ 1 หรือระดับ

จุลภาค (Micro Level) ซึ่งจะแสดงรายละเอียดของโม

เดลไว้ในส่วนของ  % WITHIN %  และโมเดลการ

วเิคราะหใ์นระดบัที ่2 หรอืระดบัมหภาค (Macro Level) 

จ ะแสดงร ายละ เอี ยดของ โม เดล ไว้ ใ นส่ วนของ              

% BETWEEN % นอกจากนี้บางโมเดลอาจต้องใช้

สัญลักษณ์หรือลักษณะเฉพาะของแต่ละโมเดล  เช่น อาจ

ใช้สัญลักษณ์ @ แทนการ Fixes a Parameter  หรือ

บางโมเดลอาจจะมี MODEL g2: %WITHIN% เป็นต้น 

ซึ่งต่อไปนี้จะเป็นตัวอย่างการวิเคราะห์บางโมเดลของโม

เดลพหุระดับ ซึ่งจะแสดงรายละเอียดดังตาราง  5





ตาราง 5


ตัวอย่างการวิเคราะห์โมเดลพหุระดับ (Multilevel Model)


การวิเคราะห์ (Analysis)
 ภาพโมเดล
 การระบุโมเดล (Model)

Two-level Regression 

Analysis for a continuous 

Dependent Variable with a 

Random Slope



 MODEL:


%WITHIN%


s | y ON x;


%BETWEEN%


y s ON w;


y WITH s;



 MODEL:


%WITHIN%


s1 | y ON x1;


s2 | y ON x2;


%BETWEEN%


y s1 s2 ON w1-w4;


Two-level Path Analysis 

with a  continuous, a 

Categorical, and a 

Cluster-Level Observation 

Dependent Variable








MODEL:


%WITHIN%


y ON x;


u ON y x;


%BETWEEN%


u ON y z w;


y ON w;


z ON w;


y WITH z
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Two-level Path Analysis 
with  continuous 
Dependent Variable and 
Random Slopes  







 MODEL:

%WITHIN%

s2 | y2 ON y1;

y2 ON x2;

s1 | y1 ON x2

y1 ON x1

%BETWEEN%

y1 y2 s1 s2 ON w;


Two-level CFA With 
Continuous Factor 
Indicators and covariates





 MODEL:

%WITHIN%

fw BY y1-y4;

fw ON x1 x2;

%BETWEEN%

fb BY y1-y4;

y1-y4@0;

fb ON w;


Two-level CFA With 
Continuous Factor 
Indicators, covariates, and 
Random Slopes





 MODEL:

%WITHIN%

fw BY y1-y4;

s1 | fw ON x1;

s2 | fw ON x2;

%BETWEEN%

fb BY y1-y4;

y1-y4 @ 0;

fb s1 s2 ON w;


Two-level Multiple Group 
CFA with Continuous 
Factor Indicators









MODEL:

%WITHIN%

fw1 BY y1-y3;

fw2 BY y4 y6;

%BETWEEN%

fb1 BY y1-y3;

fb2 BY y4 y6;

MODEL g2: %WITHIN%

fw1 BY y2-y3;

fw2 BY y5 -y6;


Two-level SEM with 
Continuous Factor 
Indicators and a Random 
Slope for a Factor





 MODEL:

%WITHIN%

fw BY y1-y4;

s | y5 ON fw;

%BETWEEN%

fb BY y1-y4;

y1-y4 @ 0;

y5 s ON fb w;


ตาราง 5 (ต่อ)
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โปรแกรม Mplus มีจุดเด่นที่สามารถพัฒนาโม

เดลการวิเคราะห์ให้เป็นโมเดลเดียวกับโมเดลการวิจัยได้

อย่างลงตัว โดยการนำเอาจุดเด่นของการวิเคราะห์โมเดล

สมการโครงสร้าง (Structural Equation Models) 

และจุดเด่นของการวิเคราะห์พหุระดับ (Multilevel 

Analysis) มาประสานเข้าด้วยกัน อย่างไรก็ตามโมเดลใน

ตาราง 4 และตาราง 5 เป็นเพียงเฉพาะบางโมเดลที่นิยม

ใช้วิเคราะห์กันโดยทั่วไปเท่านั้น  ซึ่งศักยภาพจริงๆ  ของ

โปรแกรม Mplus  ยังมีจุดเด่นที่สามารถใช้วิเคราะห์

ตัวแปรจัดประเภท (Categorical)  หรือโมเดลผสม 
 

(Mixed Model) หรือโมเดลอื่นๆ  อีกจำนวนมาก ซึ่งผู้ที่

สนใจสามารถศึกษาข้อมูลเพิ่มเติมได้จากตัวอย่างโมเด

ลการวิเคราะห์โดยทั่วไป หรือรายละเอียดในคู่มือ

โปรแกรม Mplus User’s Guide ซึ่งมีตัวอย่างภาพโม

เดลและการระบุโมเดลไว้ให้ศึกษามากกว่า 150 ตัวอย่าง

ซึ่งผู้วิจัยสามารถเลือกนำมาประยุกต์ใช้ให้สอดคล้องกับ

ข้อมูลงานวิจัยได้อย่างสะดวก


เทคนิคเพิ่มเติมในการวิเคราะห์ข้อมูลด้วย

โปรแกรม Mplus


(1) การจัดเตรียมข้อมูล  ตัวแปร Grouping 

และหรือตัวแปร Cluster ก่อนการแปลงไฟล์ข้อมูลให้

เป็นภาษา ASCII หรือไฟล์ .dat  จะต้อง Sort  ข้อมูลให้

เรียงลำดับจากน้อยไปมากก่อน โดยใช้เมนูคำสั่งใน

โปรแกรม SPSS จากเมนู Data>Sort Cases…>เลือก

ตัวแปรใส่ในช่อง Sort by:>กำหนดเลือก Ascending 

(เรียงจากน้อยไปมาก) >OK


 (2) การวิเคราะห์โมเดลพหุระดับ ในส่วนของ  

% WITHIN %  หมายถึงรายละเอียดโมเดลในระดับ 
 

1 หรือระดับจุลภาค (Micro Level) ส่วนของ  
 

% BETWEEN %  หมายถึงรายละเอียดโมเดลในการ

วิเคราะห์ระดับ 2 หรือระดับมหภาค (Macro Level) 

และเนือ่งจากตามหลกัสถติใินการวเิคราะหข์อ้มลูในโมเดล
 

พหุระดับ  ตัวแปรสังเกตได้ในระดับ BETWEEN เป็นค่า

เฉลี่ยของตัวแปรระดับ WITHIN จึงไม่สามารถวัดได้

โดยตรง  ดังนั้นจึงถือเป็นตัวแปรแฝง  ซึ่งจะแสดงตัวแปร

เป็นสัญลักษณ์วงกลม 


(3) การระบุตัวแปรในการวิเคราะห์โมเดลพหุ

ระดับ (Multilevel Model) ในชุดคำสั่งระบุชื่อและชนิด

ตัวแปรที่ใช้ในการวิเคราะห์ (VARIABLE)  ตัวแปรใดที่อยู่

ทั้ง 2 ระดับไม่ต้องนำมาระบุในส่วนของ WITHIN และ

หรือ BETWEEN 


(4) ใช้เมนู Window เมื่อต้องการสลับหน้าต่าง 

Syntax (ไฟล์ .inp) เป็นหน้าต่าง Output  (ไฟล์ .out)  


(5) ในการวิเคราะห์ข้อมูล  บางกรณีเกิด 

Warning โปรแกรมไม่สามารถแสดงผลการวิเคราะห์ได้  

ให้ทำการตรวจสอบและพิจารณาปัญหาที่เกิดขึ้นจากผล

การวิเคราห์ (Output) และให้ทำการแก้ไขปัญหาที่เกิด

ขึ้น จากหน้าต่าง  Syntax  หรือไฟล์นามสกุล .inp แล้ว

ทำการสั่ง Run ใหม่โดย Click ที่เมนูสัญลักษณ์    

และถ้าหากผลการวิเคราะห์ยังเกิดปัญหา Warning ก็ให้

ทำการแก้ไขและ Run ใหม่ทุกครั้ง จนกระทั่งโปรแกรม

สามารถแสดงผลการวิเคราะห์ให้  ต่อไปนี้เป็นตัวอย่าง 

Warning ในโปรแกรม Mplus อาทิเช่น


*** ERROR in MODEL command


  To declare random effect variables, 

TYPE = RANDOM must be specified


in the ANALYSIS command.


ในกรณีนี้ต้องระบุ  RANDOM หลังประเภท

การวิเคราะห์ TYPE IS TWOLEVEL RANDOM;


*** ERROR


 Invalid symbol in data file:


“?” at record #: 60, field #: 1


ในกรณีนี้ไฟล์ข้อมูลบรรทัดที่ 60 มีสัญลักษณ์ 

? ต้องแก้ไขรายละเอียดในไฟล์ข้อมูลให้ถูกต้อง


*** WARNING in ANALYSIS command


  Estimator MLM is not allowed with 

TYPE=TWOLEVEL.


  Default will be used.


  ในกรณีนี้การวิเคราะห์ TWOLEVELไม่

สามารถประมาณค่าได้ด้วยวิธี MLM อาจเปลี่ยนเป็นวิธี 

MLR;
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(6) ใช้สัญลักษณ์ * แทนการ Frees a 

Parameter  ใช้สัญลักษณ์ @ แทนการ Fixes a 

Parameter ส่วนการปรับโมเดลกรณีการวิเคราะห์

องค์ประกอบเชิงยืนยัน (Confirmatory Factor 

Analysis) หรือการวิเคราะห์โมเดลสมการโครงสร้าง       

(Structural Equation Models) สามารถใช้คำสั่ง with  

เช่น x3 with x1 


(7) ข้อจำกัดของโปรแกรม  Mplus Version 

Demo สามารถวิเคราะห์ตัวแปรตามได้สูงสุดจำนวน 6 

ตัวแปร  ตัวแปรอิสระได้ไม่เกิน 2 ตัวแปร  และตัวแปร

ในระดับ  BETWEEN ไม่เกิน 2 ตัวแปร


(8) โปรแกรม Mplus ที่มีลิขสิทธ์ถูกต้อง 

ออกแบบมาเพื่อ Run ใน Window Vista ซึ่งไม่สามารถ 

Run ได้ใน Window XP  ฉะนั้นถ้าเครื่องคอมพิวเตอร์

เป็น XP หรืออื่นๆ  สามารถตั้งค่ากำหนดการเปิดเครื่อง

เป็น 2 ทางเลือกคือเมื่อจะ Run โปรแกรมก็เลือกเปิด

ทาง Window Vista  


(9) ชดุคำสัง่ในการวเิคราะหข์อ้มลู (ANALYSIS) 

มีวิธีประมาณค่าพารามิเตอร์ (ESTIMATOR) ให้เลือก

หลายวิธี ได้แก่ ML  MLM  MLMV MLR MLF  MUML 

WLS  WLSM  WLLSMV  GLS  และ ULS


(10) นอกจากนี้รายละเอียดแต่ละชุดคำสั่ง      

(Command) ยังมีทางเลือก (Option) อื่นๆ ซึ่งผู้วิจัย

สามารถศึกษาเพิ่มเติมได้จากคู่มือของโปรแกรม Mplus 

User’s Guide  ซึ่งสามารถดาวน์โหลด (Download) ได้
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